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Cffu 3.'l'rong MS Word 2010, d6 chgn khdi tircon trti rC Aiu tii li0u nh6n

\^A

TAI LIEU OX TAP

Ciu l. 'l'6n goi nio say tl6y kh6ng ph:ii ln tOn ciia b6ng m5 ti6ng Viet.

A. ]'CVN 3

B. l'elcx
C. Unicode
D. VietWare_X

Caru 2. n'l6i t$p tin MS Word 2010 duo.'c luu lai sE c6 tlu6i (phAn mo rQng)
m4c dinh li

A. Ctrl +' I lome
B. Ctrl + End
C. Ctrl + Page up
D. Ctrl + Shift + Home

CAu 4. Trong MS Word 2010, thao trlc nh6n gifi'phim Ctrl trong khi rG mQt
hinh vd sE c6 tric dgng gi?

A. Sao chep doi tuqng
B. Di chuyen ddi tugng
C. Xoay ddi tuqng
D. 1'hay doi kich thudc cua d6i tu<r. ng

cAu 5. 'l'rong vin bin MS word 2010 dang mti, mudn thay tdt cri chfi'o,vN'o
thirnh "Viet Nam" thi

A. Trong the Home, chon Clear
B. Trong the I lorne, chon Go 'fo
C. 'l'rong thi I lome, chon Advanced ltind
D. 'l'rong thi I lon"re, chon Replace

cflu 6.'l'rong MS word 2010, lQnh nio sau tlffy khdng phii lir l6nh cft?

A. Ctrl t-C

I]. Nh6n nut Cut tr6n thanh c6
C. NhAn chu6t phAi chon Cur
D. Ctrl + X
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CiuT' Trong MS Word 2010, tI6 chin c6c hinh tlcrn gi:in nhu hinh chfr nh{t,trdn, elip, tam giric... ta ggi IQnh gi?

1 rai th6 Insert, Nh6n nft Shapes roi chon hinh c6n v€,
B. TAi th6 Insert, Nh6n nirt TextBox
C. Tai th6 Insert, Nh6n nrit Screenshot
D. Tai th6 Insert, Nh6n nirt SmartArt

C1u 8' Trong MS Word, anh (chi) sfr dgng t6 hqp phfm niro tI6 tuu tiri ti6uhiQnt4i? 'r I ---- 
'

A. Ctrl + X
B. Ctrl +A
C. Ctrl +S
D. Ctrl + V

cau 9. Khi thao fa: llong MS word 20100 rh6ng b6o ,,I)o you want to save
changes to..." xu6t hi6n khi nho?

A. Khi chgn mQt p_h6ng cht (font) rnd n6 kh6ng t6n tai lrong hQ th6ng.
B. Kh6ng dflt t6n file khi luu vdn b6n
C. Khi d6ng vdn b6n nhrmg vdn b6n chua duoc luu
D' Khi luu vdn bin v6i t6n file trung voi m6t file dd c6lrong thu muc 1;a chon
Cau 10' Trong MS Word 2010, thao tric nio du6i dffy tlucrc dirng d6 chgn mQttir trong do4n vln bin?

A. Gifr phfm ctrl vd Nh6n chuQt trrri Ien c6u can chon
B. Gifr phfm shift vd Nh6n chuQt tr6i l6n c6u can chon
C. Nh6n chuQt tr6i 3lAn vdo te trai cila vdn b6n
D. Nh6n d6i chu6t tr6i l6n tri cAn chon

cau 11. Trong MS word 2010, t6 hcrp phim niro dring d6 ting, girim co chfr
cho nQi dung vin bin?

A. Ctrl + 1

B. Ctrl -r- 2
C. Ctrlr-1 hay Ctrl+l
D. Shift+[ hay Shift+1

S.:l 
,r.Trong MS word 2010, mu6n chgn nhiiiu hinh v6 el6ng thd,i ta thu,c

nren

* It?r.Pnl t,rdi b yyns tr6ng vh 16 nsans qua c6c.d6i ruqng cAn chon
P Yr?, gifi'ph(m shift vd Nh6n chuot t.ai re, c6c d6i ,"1"g ,ira" .rrn"
! Nhan gi& phfrn Alt vd Nh6n chu6t triii len ciic aoi t.,*[ ilra, .rro"
D. Vdo menu Edit, chon Select All AutoShape
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Ciu 13. Trong MS Word 2010, t6 hg'p phim Ctrl + S tlug'c thay cho lQnh niro
du6i dffy?

A. Vdo []ile, chon l6nh Save and Send
B. Vao Irilc, chon lenh Save
C. VAo Irilc, chon lenh Opcn
D. Vdo Irile, chon l0nh Save As

C.au 14. Trong MS Word 2010, khi dang so?n thrio v[n bfrn tI6 xr{c ilinh t6ng
sd trang ciia vin brin hiQn hhnh ta quan s6t 6'

A. Thanh c6ng cu Ribbon
Il. 'l'hanh trang thai
C. 'l'rong trang Backstage cua thuc dorn Irile
D.'l'hanh ruler

Ciu 15.'frong MS Word 2010, tI6 tao g?ch ch6n cho ilogn vin bfrn dang lqra
chgn vfi n6t don thi ta thgc hiQn

A. NhAn Ctrl + tJ
B. Nhdrn Ctrl -l- V
C. Nh6n Ctrl + C
D. Kh6ng thpc hi6n dugc

Cdu 16. Trong MS Word 2010, <16 gQp c:lc 6 dang chgn cira mQt bfrng thdrnh
mQt 6 thi ta ggi lQnh niro?

A. Vao thi Layout, Nh6n niit Margin Cells
Il. Vdo the [.ayout, NhAn nrit Split fable
C. Vao the [-ayout, Nh6n nirt Merge Cells
D. Vdo the Layout, Nhdn nut Split Cells

C6u 17. TOn ggi niro sau tlf,y lir t6n ciia ki6u gd titing ViQt

A. TCVN 3

B. VNI
C. VictWare_.X
D. Unicode

CAu 18. -l'rong MS Word 2010, khi cffn 96 crlc chi sd du6i IdzO thi sri'dqng
t6 hqp phim tit niro trong khi 96?

A. Ctrl , ,

B. Ctrl Shift:
C. Ctrl Alt Shift :
D. Shift:
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C6u 19. Trong MS Word 2010, d6 ch6n m6t chfi,nghQ thuit (Word Art) vio
vin bin ta ggi lQnh gi?

A. 'fai th6 Insert, Nh6n nut euickpart
B. Tai th6 Insert, Nh6n nirt ClipArt
C. Tai th6 Insert, NhAn nrit WordArt
D. 'I'qi th6 Insert, Nh6n nirt Equatiorr

C6u 20. Sri'dgng ki6u 96 nio d6 khi nh?p hai chfi,A 116 cho chir A, hai chir E
sG cho chfi'E?

A. Telex
B. Select
C. \TNI
D. Latex

CAu 21. Phdt bi6u nio sau tliy lh dring?

A. Tap tin dugc tao ra bdi MS Word 2010 khi luu sE co du6i mac dinh ld XLSX
B. Trong MS Word 2010 ta khdng the 96 tiring ViQt
C. MS Word 2010ld m6t phan m6m tinh toiin
D. Mpc dinh mdi khi kh6i d0ng MS word 2010 dd co mQt vdn b6n tr6ng

Cdu22. Trong MS Word 2010, d6 chin mQt ti6u tI6 viro t6 OuOi vin b:in dang
mb, ta thgc hiQn:

A. Tai th6 Insert, Nh6n Footer, chgn m6t m6u ti6u d6
B. TAi th6 Insert, Nh6n nirt Header, chgn m6t m6u ti6u d5
C. TAi th6 Insert, NhAn nrit Footer, chon Remove Footer
D. Tai th6 Insert, Nh6n ntt l{eader, chon Edit t-leader

cffu 23. Trong MS word 2010, do n6i hai do4n vin thinh mQt clo4n ta thq,c
hiQn:

A. EAt con tr6 dAu dopn thu 2,nh6n backspace
B. DAt con tr6 dAu dopn thv 2,nh6n delete
C. Ddt con tr6 dAu doan thir l, nhAn backspace
D. EAt con tr6 dAu doan thf l, nhAn clelete

Ciu 24. Trong MS Word 2010, Oti Oann s6 trang & t6 AuOi cria thi liQu ta goi
lQnh nio?

A. Vdo Insert, Nh6n Page Number vd chon'fop of page
B. vdo Insert, Nh{n Page Number va chon current positLon
C. VAo Insert, Nh{n Page Number, chon Bottom of page
D. Vdo Insert, Nh6n Number page, chgn page Margins
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CAu 25. Khi thao tic trong MS Word 2010, th6ng b6o "'I'he file already
exist" *r6t t ign khi niro?

A. Kh6ng dpt t6n hle khi luu vdn bin
I]. Khi chgn m6t ph6ng chir (font) ma no kh6ng t6n tai trong hQ th6ng
C. Khi luu vdn ban v6i t6n file trung v6i m6t file dd c6 trong thu muc lua chon
D. Khi dong vdn b6n nhung van bdn chua duo-c luu

CAn 26. 'l'rong.MS Word 2010, khi cin thay d6i miu n6n cho hinh vE dang
chgn thi ta Nh6n nrit niro trong the t'ormat r6i chgn miru?

A. Shape Fill
B. Shape Outline
C. Shapc lrflbct
D. Lldit Shape

Cdu27.'frong MS Word 2010, d6 chin hinh 6nh tir thuviQn c6 sin trong
Word vio vin bin, ta thgc hiQn:

A. Tai the Insert, Nh6n n[.rt Picture
B.'l'qi the Insert, Nh6n nut SmaftArt
C. I'ai the Inserl, Nh6n nut ClipArr
D. 'l'ai tl-rc lnsert, Nh6n nut Screenshot

Ciu 28. Standard lir m6t...cfra Microsoft Word dirng d6 thao t6c vfi t{p tin
vin bzin.

A. 'l'hanh c6ng cu
B. Mcnu
C. I IQp tho4i
D. frang giay

Ciu 29. Trong MS Word 2010, oG nriy b6 chir to tliu do4n (Dropcap) rli tlo
cfia do4n vin bin ta thr;c hiQn lQnh gi?

A.'l'ai the I'lome, Nh6n nut Dropcap
I]. 'l'ai thi Insert, NhAn nut Dropcap vd chon None
C. 'l'qi the Insert, Nh6n nirt Dropcap
D. Tai thd Insert, Nh6n nrit Dropcap vd chgn Dropped

Ciu 30. Trong MS Word 2010, cI6 chdn mQt scr AO tO chric vio vin bin ta ggi
lQnh gi?

A.'fai the lnserl, Nh6n nut Shapes
ll. 'tai the Inserl, Nh6n nut WordArt
C. 'l'ai the Inserl, Nh6n nut Chart
D. Tai the Insert, NhAn nrit SmartArt
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c.aq st. Trong MS word 2010, anh (chi) sii'dgng tii hqp phfm nio d6 canh
d6u 2 bOn cho doan vin bin?

A. Alt+X
B. Ctrl + O
C. Ctrl +J
n. f'6t ci dAu sai

cdu32. Trong MS word 2010, cdng dung ciia t6 hgp phim ctrt + c lh gi?

A. sao ch6p c6c n6i dung dang lua chon vdo trong b6 ntLo d6m
B. Phuc h6i lai c6c thao t6c da ldm truoc d6
C. D6n $rt chc6c nQi dung dd duoc sao chdp tru6c d6 vdo vi tri con tro
D. T'hUc hi6n canh lA gifia doan vdn ban do

Cau 33. O6 titrOi d0ng MS Excet ta chsn t0nh:

A. Start Programs Microsoft Word
B. Start Programs Microsoft Excel
C. Start Programs Microsoft Fontpage
D. Start Programs Microsoft Powerpoint

cfiu 34. Tiri li6u cfra MS Excel du'g'c luu tr6n dia v6i phAn mri.rQng:

A. DOC
B. XLS
C. JPG
D. BMP

cffu 35. Trong Excel hirm DAY(AS) ['I'rong do A5 = 1g/0s/200g1 trri vii:

A. 56 ndm cria bi6n ngAy th6ng ,A5 le 2008
B Si thdngtrong n6m cria bi6n ngay th6ng ,A5 le 05
C. 56 ngay trong th6ng cria bi6n ngAy th6ng ,{5 le I B
D. Ngdy th6ng hi6n tai cua h6 thdng

Cflu 36. Him DAY("22/1012007,') cho k6t qu6:

'rdt ce dAu sai

0720
10

22

A.
B.
C.
D.

Cdu 37. Trong Excel him MON'l'[I(clate) tr6 v6:
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A.r
B.9
c. l0
D. 2008

A.
B.

C.
D.

08A.20,
Il. l9
c.8
D. l'a

A. 55 th6ng trong ndm cua bien ngdy thang date
I3. Ngay th6ng hi6n tai cua h0 thdng
C. Sf, ndm cua biOn ngdy th6ng date
D. So ngdy trong th6ng cua bi6n ngdy thang date

C6u 38. Hirm MONTH("09-Jan-2008") cho k6t qu6:

Ciu 39. Trong Excel hirm YEAR(date) tri v6:

Nguy th6ng hi6n tai cua hQ th6ng
56 ngay trong th6ng cta bi6n ngay th6ng date
So ndrn cua bi6n ngdy th6ng datc
56 th6ng trong ndm cua bi6n ngay th6ng date

C0u 40. Hhm YEAR("19-08-2008") cho k6t quri:

tca ddu sai

Cffu 41. Trong Excel hirm TODAYQ trfr vd:

A Si ngay trong thdngcua bi6n ngay th6ng date
Il. So ndm cua bi0n ngdy thang date
C. 56 thang trong ndm cua bien ngdy th6ng date
D. Ngay th6ng hi6n tai cua hO th6ng

Ciu 42. Hirm LEFT("Microsoft Windows XP", 9) cho k6t qui:

A. "Windows X"
B. "Microsoft Windows"
C. "Windc)ws"
D. "Microsoft"

Ciu 43. Hhm LllN("Microsoft Excel 5.0") cho k6t qufr:

A. 19

Il. l7
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c. ls
D.25

cfu 44. Hirm Rrc[IT("Microsoft Irrcel 2003",4) cho k6t qu6:

A. "Microsoft Excel 2003"
B. "lVicrosoft"
C. "Excel 2003"
D. "2003"

C6u 45. Hhm TRIM(" Microsoft llxcel 2003 ")

A. "Micro soft"
B. "Microsoft Excel"
C. " Excel 2003"
D. "Microsoft Excel 2003"

CAu 46. Him MID(,,Microsoft Excel 2003,,,10,5)

A. "'Microsoft"
R.'ollxcel"
c. "2003,,
D. "Excel 2003"

Ciu 47. Trong MS Excel hirm ABS(A7) { A5 : -5} dtng iI6:

A. T'fnh gi6 tri tuy6t d6i cua s6 A7 .,,, 5

B. Tinh t6ng cua sO aZ
C. Tinh cdn bpc hai cria sO aZ
n. T6t c6 ddu sai

CAu 48. Trong MS Excel hirm SeR't'(A9) dtng tI6:

A. Tinh t6ng cira sO aq
B. Tinh gi6 tri tuyQt d6i cua sO ag
C. Tinh cbn b0c hai ctra sO Ag
D. Tat cd d6u sai

Cirru 49. Hhm SUM(-I 2, -5,7, 100) cho k6t qud:

A. 100
8.9
c. -90
D. 90
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CAu 50. Hhm MAX(8, 29, -ll, 33, -51) cho k6t qu:i:

A. -51

u.8
c. 33

D.29

C6u 51. Ilirm MIN(-52,20, -11,23, -15) cho ki5t qu:i:

n.20
Il. 23

c. -s2
D. -15

Ciu 52. Trong bzing tinh Excel, t4i 6 L2 c6 sin gi6 tr! s6 25 ; Tai 6 B2 96 vio
c6ng thri'c :SQR'l'(A2) thi nhAn du'g'c k6t quri:

A..0
8.5
C. #VALUE!
D. #NAME!

Ciu 53. D6 tqo mQt slidc gi6ng het nhu'slide hiQn hinh mh khdng phrii thi6t
k6 l4i, ngutri sri'dgng:

A. Chon Insert -> Duplicate
B. Chon Insert -> New Slide
C. Chon Insert -> Duplicate Slide
D. Khong thuc hiQn dugc

C6u 54. D6 cin lii cho mQt do4n vin bin nio d6 trong gi6o 6n eliQn tir dang
ttri6t k6, tru6c ti6n ta ptrii:

A. Dua con tro v6n b6n vdo giira dopn vdn b6n cAn cdn 16

B. Chon c6 dopn vdn bdn cin can ld
C. Chon mQt dong bat kj,trong dopn vdn b6n cAn cin lA

D. Ca 3 c6ch n6u trong cdu niry deu dung

Cffu 55. Mu5n x6a slide hiQn thdi kh6i girlo rln tliQn tfr, ngud'i thi6t k6 phii:

A. Chon t6t cA c6c d6i tugng tr6n slide vd nh6n phim Delete.
Il. Chon t6t cd cac doi tuong tr€n slide vd nh6n phim Backspace.
C. Chon trdit -> Delete Slide .
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D. Nh6n chuQt phai l6n slide vA chon Delete

ciu 56. D6 luu mQt tlo4n ,nin bdn de du,gc ch,rr vho vtng nh6 tIQm(clipboard) mir kh6ng tim m6t di doSn vin bin d6 t; nrr6, t6;;; phfm:

A. Ctrl + X
B. Ctrl + Z
C. Ctrl + C
D. Ctrl + V

CAu 57. Dang thi5t k6 girio rln tliQn tti', tru6'c khi thorit khoi powerpoint n6u
n-su'd'i sri'dgng chua ru'u r4i tap tin thi mrry sG hiQn mQt th6ng brio. lr5 il i;tip tin niy ta sE kich chuQt tr6i vho nrit nio trong bring th6ng brlo nhy?

A. Nut Yes
B. N0t No
C. Nut Cancel
D. Ntt Save

cdu 58. Mu6n sao ch6p mQt phAn cria tlo4n vin brin trong mQt-I.ext Box, taphfri:

A, CrhOn ph?n vdn b6n cAn sao chep, nh6n Ctrl + C r6i drra con tro vdn brin d6n vi
trf cdn sao ch6p, nh6n Ctrl + V
B, C,hOn ph?n vdn b6n cAn sao ch6p, nh6n Ctrl -r- V r6i drra con tro v6n ban d6n vi
trf c6n sao ch6p, nh6n Ctrl + C
C. Chqn Text Box chira dopn v6n ban cJ6, nh6n Ctrl + C r6i dua con tro vdn ban
d6n vi tri cAn sao chdp, nh6n Ctrl + V
D Chgn Text Box chria doan v6n bAn do, nh6n Ctrl + V r6i dua con tro vdn b6n
d6n vi tri cAn sao chdp, nh6n Ctrl +

Ciu 59. Thao t5c chgn Edit -> Delete Slide lir tI6:

A. X6a slide hiQn hdnh
B. X6a tfp rin c6 nQi dung ld bei trinh diSn hiQn hdnh
c. Xoa t6t cdc6c slide trong bdi trinh di6n dang iniai r.e
D. X6a tix. citc6c d6i tugnglrong slidc hiqn hdih

Ciu 60' Khi thyc hiQn thao tic chgn Insert -> Movier; and Soun6s nguli sri,
dgng:

I thi dugc phdp chdn hinh 6nh viio gi6o 6n

I gli dusc ph6p chen 6m thanh veo gi6o 6n
C. Chi duoc ph6p chen phim viro gido 6n
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D. Co the chen Am thanh hoac phim vao giao 6n

Ciu 61. OO ttriOt l$p c5c thdng sd t.ang in ta thqc hiQn:

A. Chon File -> Page Setup
B. Chon lrile -> Print
C. Chon I"'ile -> Print Preview
D. Chon lrile -> Properties

ciu 62. oG t6 mhu n6n cho mQt slide trong bhi trinh di6n ta thg,c hiQn:

A. Chon View -> Ilackground
Il. Chon l:rormat -> Background
C. Chon Insert -> Backgroun
D. Chon Slide Show -> Background

Ciu 63. OA tOt thrlc viQc trinh di6n trong PowerPointo ta b6m:

A. Phirn l0
I]. t'}hirn I:SC
C. l'}hinr I)elete
D. Phirn l'.nter

Ciu 64. Khi dang lhm viQc vfi PowerPoint, ,rru6n trinh di6n tii li€u tluqc
so4n thrioo ta thg'c hiQn:

A. trilc - View Show
B. Window - View Show
C. Slide Show - View Show
D. Tools - View Show

-1
lou'\>./
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Ciu 65. Khi dang lirm viQc v6'i PowerPoint, -16, thi6t lap lai bd cgc (trinh
bny v0 vin b:in, hinh rinh, bi6u 06,...) cria Slide, ta thg'c hiQn:

A. I"ormat - Slide [,ayout...
B. View - Slide Layout...
C. Insert - Slide Layout...
D. Irilc - Slide I.ayout...

Ciu 66. Khi dang lim viQc vri'i PowcrPoint, mudn thay AOi ttriOt kd cta Slide,
ta thq'c hiQn:

A. F-ormat - Slide Design.
B. l"ools - Slide Design...

i\
lt
7
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C. Insert - Slide Design...
D. Slide Show - Slide Design...

Ciu 67. Khi dang lirm viQc v6'i PowerPoint, d6 chin th6m mQt Slide mcri, ta
thq'c hiQn:

A. Edit - New Slide
B. File - New Slide
C. Slide Show - New Slide
D. Insert - New Slide

c6u 68. E6 trinh di6n mQt slide trong powerpo int, te, b6m:

A. Phfrn F5

Il. Phim F3
C. I'}him F1

D. I'hfrn F'10

Ciu 69. Chgn il6p rin dring:

A. IGB: 1000MB
B. IGB: 1240MB
C. 1GB : 1204MB
D. lGB : l024MB:210 MB

Cffu 70. Chgn phit bi6u SAI t O nit (Binary digitf

A. Le don vi do th6ng tin nho nh6t ducrc su'dung trong nr6y tfnh
B. !A dang bi6u diSn th6ng tin g6rn 2 giatr! 0 vd I
C. La don vf d6 th6ng tin 16n nh6t duq:c su'dqng trong m6y tinh
D. I-d hp d6m nhf ph6n

Ciu 71. Nh6m c6c thi6t b! nho sau dfly l}r thi6t bi luu trir ngo4i vi cria m6y
tfnh?

A. RAM, [JSB, The nhcr
I]. ITOM, CD.ROM, USB
C. USB, Th6 nh6, DVD
D. Eia cirng, USB, The nh6

cdu 72. rni6t bi nho dugc vf nhu' la bg nf,o cfra mriy t;nh?

A. Input
B. CPU
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C, Output
D. AI,T]

Ciu 73. Ph6p c0ng s6 nhi phin ll0ll v6'i 10011 cti k6t quri nio sau dffy?

A. 101 1 00
B. r 10 r00
c. r0rrl0
D. l l0l l0

A. 64
B. r28
c.256
D. 65536

ca,rt 74. Khi n6i vii m6y tinh c6 nhdn, ph6t bi6u niro durvi rl6y ihing:

A. Ld lopi m6y vi tfnh kich thu6c nho v6i gi6 cA th6p vd hiru dUng cho tung c6
nhAn

13. May tinh co hQ di6u hdnh chi phuc vu cho mQt ngucri
C. May chi dung d0 tinh to6n thong thucrng nhu m6y tinh bo tiri CASIO, CASIO
FX500
D. M6y tinh vcri kich thu6c r6t lon co the bing ca mQt roa nhh

Ciu 75; Trong hC th6ng mrly tinh, mQi viQc tfnh to6n dug'c thlrc hiQn trOn
d?ng s6 nho du6'i d6y?

A. Il6t phAn

B.'l'hap phAn

C.'l'hap lpc phdn
D. Nhi ph6n

Cdu 76.1i6 m5 lJnicode mi h6a ttii Oa bao nhi6u kf ty?

=I
YNG
1M

llru
,1,

IAT

*

CAn 77.1i6 nhri'truy xuit ng6u nhiOn (RAM) ctia m6y tinh lh vi6t tit cfia?

A. Record Access Memory
B. Read Access Memory
C. Random Access Memory
D. Read Application Memory

C6u 78. flf,y chgn phrit bi6u dring trong c6c ph6t bi6u sau:
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A. 'l'ai m5i tnOi di6rn rn6i phAn rnOrn qudr virus chi di6t ducyc m6t so loai virus
nhAt dinh

I g.hi cdn.mQt phan m.m diet virus la co th6 ti6u diQt 6t cec6c virus
9 lhe" mcm qu6t virus BKAV b6o v6 an todn loo% cho m6y tinh
D. M6y tinh kh6ng k6t n6i Internet thi kh6ng bi nhi6m virus

CAu79. Ph{t bi6u n}ro sau rl6y l}r kh6ng dtng?

A. Mriy qu6t, webcam, bin phfm lA c6c thi6t bi vdo
B. Loa, mdn hinh , m6y chi6u, m6y in lit citctni6t bi ra
C. Modem, mdn hinh c6m irng ld cac thi6t bi vdro/ra
D. ROM, RAM, dia cring ld c6c thiet bi luu trfr trong

9ll 89. Trong qud trinh mriy tfnh dang lim viQc, dfi, liQu du,gc luu trlr tamthd'itr6n: ' ---i-- i -

A. RAM
I]. ROM
C. DVD
D. CI)

cau 81. HQ nhi phfln dtng bao nhi6u ky tu oo uiou di6n c6c s6?

A. Nanobyte
B. Kilobyte
C. Ilit
D. Megabyte

Ciu 83. I byte bnng bao nhi6u bit?

A.8
B. 16

c.32
D. 64

0

6

2

1

8

I

A.
B.
C.
D.

c6u 82. Dcrn vi nho du6i cl6y kh6ng crtng o6 oo luryn:E th6ng tin?

Ciu 84. Phdt bi6u nio sau diy lir kh6ng dring?
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A. M6y qu6t, webcam, ban phfm la thi6t bi vdo
B. Loa, rnan hinh , m6y chi6u, m6y in ld thi6t bi ra
C. Modcrn, man hinh ciim ung ld thiet bi vaolra
D. ROM, RAM, dTa cu'ng la thiOt bi lLru trir trong

C6u 85. I]6 nh6'nho dugc sti" dgng <I0 luu trii'dfr liQu t3m thd'i trong quf trinh
mrly tinh dang ho4t dQng?

A. ROM
I]. RAM
C. Rcgistcrs
D. Modem

ciu 86. rni6t bi nho sau tl6y khdng thuQc bQ nhf ngoiri mrly tinh?

A. Irloppy disk
B. Monitor (mdn hinh, kh6ng phai bo nhtl)
C. t{ard disk
D. USB disk

Cf,u 87. fhi6t bi niro vtra lir thi6t bi vho, vira lh ttriOt bi ra?

A. Monitor
IJ. Modcrn (thiet bi vi0n thong)
C. Printcr
D. Projector

Cffu 88. Trong m?ng mriy tfnh, thu$t ngfr'WAN c6 nghia li gi?

A. Mang cuc bo
13. Mang dien r6ng
C. Mqng toan cAu

D. Mang LAN

C6u 89. Hiy chi ra t6n cria thi6t bi m4ng?

A. TJSR

B. r.iPS

C. Switch
D. Webcam

CAu 90. PhAn -dm hQ th6ng:

A. La phdn ,rd- de giai qry6t nhfrng viec thuong g6p

e
i TAM

sar,
KINH
,IHUI

lililH

=4
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R. c6 chirc n6ng gi6m s6t vd di6u ph6i thuc hi6n c6c chuong trinh.
C. Con dugc goi la chuong trinh gi6m sat.
D. Con c6 t6n kh6c la phAn m6rn ung clung.

c6u 91. Phdt bi6u nho du6i ddy kh6ng phrii lh cria cpu?

A. Dung d6 nhdp va luu trirth6ng tin.
B. Thdnh phAn quan trgng ntr6t cua rn6y tinh.
C. Thi6t bi chinh thuc hi6n vd di6u ktriCn vi6c thuc hi64 cira chucrng trinh.
D. Gdm hai bQ phdr chinh le bo dieu l<ien va b0 ro rroq logic.

CAu92. Chg n phit bi6u ihing trong crlc ph6t bi6u sau:

A. DAu vdo ld chi c6c dfr lidu vd l6nh dua vdo m6y tinh.
B. Xy lf ld chi nhfrns ei mdy tinh ldm v6i l6n h trong m6y tinh.
C. DAuia ld chi bit A'AI .rirlua trinh *rliy. 

-

D. Kh6ng c6n phai dua dAu viro vd chi 16 chu trinh xri 11,.

!:r-.?3. f-!i lan gti'i mQt tin ttr m65, tfnh b4n tl6n mriy tinh cria nguli kh6c,
bQ di6u gi6i il6ng vai trd gi?

A. T'hi6t bi dAu vdo.
B. tsQ ngoai vi.
C. T'hi6t bi ddu ra.
D. tlQ n6 i vi.

Cf,u 94. HQ tli6u hinh lir:

A. PhAn mAm hQ thdng.
B. PhAn mAm t?ng dung.
C. PhAn mdm van phong.
D. PhAn mdm c6ng cq .

Ciu 95. Chfc ning nio dufi il6y kh6ng thuQc chri'c n,ing hQ tli6u hinh?

1. _Cy"g c6p c6ng iu tim ki6m vd truy c6p th6ng tin.
B. Td chfc giao ti6p gifi,a trang web voi hQ th6ng.
C. Cung cdp tiri nguy6n cho chucrng trinh.
D. Cung c6p dig h vq tidl fch h6 th6ng.

C6u 96. M?ng mdy tinh ti?

A' Tap hop c6c m6y tfnh du<vc n6i ,cri nhau theo rn6t phrrcrng thfrc ndo d6.Il. TAp hqp c6c m6y tinh.
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C. Mang t.AN.
D. Mang co day

cdu 97. cric mqng mdy tinh tlug'c thi6t k6 vi ciri il{t theo quan tli6m:

A. Co cAu truc da tAng
B. Nhicu t6ng
C.'Iheo lcrp

D. TQp hqp

Ciu 98. Khi sii dgng m?ng mriy tfnh ta sG thu dugc c6c lqri ich:

A. Chia se tdi nguyen (6 cung, co so dir liQu, m6y in, cac phdn mdm tiQn ich...)
B. Qudn ly tap trung
C. l'dn dung ndng lgc xu ly cta c6c m6y tinh r5i kOt hqp lai dC thuc hi6n c6c c6ng
viQc lcrn

P. f6t ca ddu dring

C6u 99. Dcrn vi crr bfrn do t5c d6 truydn dir liQu ti:

A. Ilit
B. Byte
C. Bps (bit per second)
D.Ilz,

CAu 100. Qud trinh dir li6u cli chuyOn tat' hO th6ng mriy tinh nhy sang hQ th6ng
mfy tinh khric phrii trrii qua giai do4n nio:

A. PhAn tich dfr li6u
B. Nen dir liQu

C. Dong goi
D. I-oc du liQu

Ciu l0l . XCt n6i .4rg sti dgng c6c giao thri'c khric nhau bing c6c:

A. Bg chuyen ti6p
13. Cong giao ti0p
C. SONE'f
D. Ilo ciinh tuv6n

J

Ciu 102. Nhug'c tli6m ciia m4ng d?ng hinh sao (Star) li:

A. Kho cai ddt vd bao tri
B. Kh6 khic phuc khi l5i cap xtry ra, vd drnh huong t6i c6c nirt mang kh6c

\
E
rE,

t0

/
+I
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c. can qu6 nhi6u c6p d6 tet noi trvi nut mans truns t6m
D. Kh6ng co kh6 ndng thay d6i khi da lap dp-t

CAu 103. D4c tli6m cria m4ng dgng Bus:

A. TAt ch cdc mit mpng, tet noi vao nut m?ng trung.tAm (vi du nhu Hub)g. r6t ca cdc nut k6t n-6i t.en gung rnQt duoig,.ia" vat ly
C. 'f6t ca cttc n[t mang.d6u k6t r5i ,rr,. tiep iOi;i;,
D. M6i n0t m4ng tet nOi vcti 2 nirr mang con lai

911 191.,T:lr.q 
ki lhr?l ch-uy6n m4ch [6nh, truric khi trao o6i flr6ng tin, hQ

th6ng sE thi6t lgp k6t n6i giira 2 rhg.c th6 bnng mQt:

A. Euong truydn vat ly
B. K6t n6i 6o
C. Duong 6o
D. Duong truy6n logic

cau 105. r6t ntii ti6n mSng c6c m?ng LAN, wAN, MAN tIQc lap v6i nhau
bnng c6c thi6t bi c6 chti'c ni'ng:

A. Ki6m so6t l5i, ki6m so6t lu6ng
B. Dinh tuy6n
C. DiAu khi6n li6n ket
D. Ei6u khi6n luu lugng vd d6ng bo hoa

Ciu 106. Crlp UTP Cat5e sri, dqng AAu niii:

A.RJ-58
u. UNC
C.RJ-45
D. ST'

Ciu 107. Cdp UTP Cat 5 c6 hao nhi0u d6i c6p:

A.
B.
C.
D.

2

4

6

8

Ciu 108' D{c di6m quan trgng ctia ki6n trric m4ng clit'nt/server (khrich/chii):

A' client/server 
P q9, tnic phan cap, client d6ng vai tr) y6u cAu va server d6p

[rng lai c6c ydu cAu d6.
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IJ. Servcr ld host lu6n hoat dQng, thucrng co IP cO dinh, co nhom c6c server dC
chia.se.c6ng viQc. Client co kOt n6i khong li6n tuc, dia chi IP co thO thay d6i,
truydn th6ng vcvi.server vA thucrng kh6ng truyen th6ng trgc ti€p v6i client kh6c.
C. CAu A vd B d6u dung
D. CAu A vd B ddu sai

Ciu 109. Khing dinh nio sau dffy ln dring khi n6i ndrn4ng c6 c6u trric tli6m-
di6m:

A. Mang quring b6
B. Noi tung cdp node lqi v6i nhau theo rnQt hinh hoc x6c dinh
C. Mang luu vd chuydn ti6p (Store - and - Forward)
D. Cac node trung gian: ti6p nh6n, luu trir tam thoi vd gui ti6p th6ng tin

Ciu.l10. Khi|B dinh nio sau diy li dring khi n6i vd nhugc di6m c[ia mang
c6 c6u trric di6m- di6m:

1 Klu nang dUng clQ thong tin (collision) th6p
B. Hi6u sudt s[r.dung duong truy6n !h6p, chiem dUng nhi6u tdi nguyen
C. Dg tr6 lon, t6n nhi6u thoi gian de thiet lqp ducrngtruydn va xu lli tai c6c node
D. 'l'oc do trao doi thong tin thAp

Ciu I I l. Khing ilinh nio sau diy' ld dring khi n6i vii o6c tru'ng cria m4ng
quring brl:

A. T6t ca cac node cung truy nhQp chung tr6n mQt duong truy6n vQt lli
B. N6i trmg cqp node lpi v6i nhau theo rnQt hinh hgc x6c dinh
C. C6c node trung gian: ti6p nhAn, luur trir tam thoi vd gui tiep th6ng tin
D. Kha n6ng dUng dQ thong tin (collision) thdrp

Cflu l12. Khing {Iinh nio sau tIAy li tltng khi n6i rd mgng chuy6n m4ch
k6nh:

A.'fhiet lap li6n k6t vat ly, truy6n du'licu va gidi phong li6n k6t gita2thgc th6
B.-l'hiet.lap lien kOt logic, truyen dfr'lieu vd giai phong lien ket gitra2 thuc the
C.'I'1uydn dir liQu giira2 thgc the
D. fhi6t lAp li6n k6t vd giai phong li€n k6t giira 2 thuc th6

Ciu I13. Khing tlinh nio sau tl6y li tlf ng khi n6i nd *4ng chuy6n m?ch g6i:

n. Goi tin luu chuyen tr6n c6c k6t nOi logic
Il. Goi tin luu chuy€n tr€n cac t<6t nOi vAt ly
C. G6i tin luu chuyen dQc lpp hucrng dich

,S

)1

'l
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? gg'^ti. luu. chuy6n trdn c6c k6t noi logic huong dich vd tren mQt duong co th6
co nhi6u goi tin cung luu chuyCn

Ciu-114. Khing ilinh nio sau tl6y lir thing khi n6i rd qu6 trinh phfln mrlnh
g6i tin:

A. Ldm gi6m thoi gian xri ly
B. Iram tdng tinh. linh hoat cua mqng
C. Anh hq*g den toc" dQ trao doi dri licu trong m?ng
D. Tdng t6c dQ trao d6i th6ng tin trong mang

Cl6u 115. Khing tlinh nio-sau tl6y li ihing khi n6i vd trrydn dfi'tiQu theo
phucrng thri:c hudng li6n k6t:

A. co clQ tin cay cao, dam bao chAt lu'o-ng dlch vu vd co x6c nhan
B. Khdng cAn dQ tin cdy cao, ch6t lugng dich vy thAp
C. C6 x6c nh{n, kh6ng ki6m so6t l5i, fiem so6t lu6ng
D. E0 tin cpy cao, kh6ng x6c nhQn

Cdu 116. Khing tlinh nio sau ilfiy li thlng n6i vA c6u tnic vat lf ciia m4ng:

A. Giao thirc m4ng (Protocol)
B. Hinh trang mpng.(Topology)
C. Phuong ti6n truy6n
D. C6c dlch vq m?ng

Ciu 117. M4ng Internet li:

A. Mang cua cric may tfnh todn cAu kOt noi lai v6i nhau theo giao thu'c 'l'Cp/lp
B. M4ng diQn rQng
C. Mpng m6y tinh todn cAu
D. Mang cria c6c mang con k6t n6i lai v6i nhau

cau 118. Trong m?ng hinh BUS, t6t cri c6c tr4m truy nh{p ng6u nhi6n vio:

A. Duo'ng truydn chung
B. Mriy chu m4ng
C. B0 nh6 dQm
D. C6c thi6t b! k6t nOi mang

Ciu 119. M4ng LAN hinh sao (S.t.AR) khi c6 sg,c6:

4. Se ngung ho4t dQng todn b6 h6 thong
B. Kh6ng rinh hucrng t6i ho4t dQng toan b9 hQ th6ng



21,

C. Chi drrh huong dtin tram co su co
D. Chi dnh huong den mot phan cua he thong

Ciu 120. v6'i ki6u k6t n6i m4ng theo d?ng hinh sao (star), khi mQt trgm trong
m?ng ngu'ng ho4t dQng thi c6c tr4nr cdn lpi:

A. I loat dQng binh thucrng
Il. Dcu ngung hoat d6ng
C. Hoat dQng kh6ng on dinh
D. Cac cdu tr6n ddu sai

IIct


